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Preface

Scientific WorkPlace and Scientific Notebook provide a free-form interface to a com-
puter algebra system that is integrated with a scientific word processor. They are de-
signed to fit the needs of a wide range of users, from the beginning student trying to solve
a linear equation to the professional scientist who wants to produce typeset-quality doc-
uments with embedded advanced mathematical calculations. The text editors in Scien-
tific WorkPlace and Scientific Notebook accept mathematical formulas and equations
entered in natural notation. The symbolic computation system produces mathematical
output inside the document that is formatted in natural notation, can be edited, and can
be used directly as input to subsequent mathematical calculations.

Scientific WorkPlace was originally developed as an interface to a computational
system, with partial support from a National Science Foundation Small Business In-
novation Research (SBIR) grant. The goal of the research conducted under the SBIR
grant was to provide a new type of interface to computer algebra systems. The essential
components of this interface are free-form editing and natural mathematical notation.
Scientific WorkPlace and Scientific Notebook satisfy both criteria. They make sense
out of as many different forms as possible, rather than requiring the user to adhere to a
rigid syntax or just one way of writing an expression.

The computational components of Scientific WorkPlace and Scientific Notebook
use a MuPAD engine. All versions use standard libraries furnished by Sciface Software.
Scientific WorkPlace and Scientific Notebook provide easy, direct access to all the
mathematics needed by many users. For the user familiar with MuPAD, they also allow
access to the full range of MuPAD functions and to functions programmed in MuPAD.
By providing an interface with little or no learning cost, Scientific WorkPlace and
Scientific Notebook make symbolic computation as accessible as any Windows-based
word processor.

Scientific WorkPlace and Scientific Notebook have great potential in educational
settings. In a classroom equipped with appropriate projection equipment, the program’s
ease of use and its combination of a free-form scientific word processor and computa-
tional package make it a natural replacement for the chalkboard. You can use it in the
same ways you would a chalkboard and you have the added advantage of the compu-
tational system. You do not need to erase as you go along, so previous work can be
recalled. Class notes can be edited and printed.

Scientific WorkPlace and Scientific Notebook provide a ready laboratory in which
students can experiment with mathematics to develop new insights and to solve interest-
ing problems; they also provide a vehicle for students to produce clear, well-written
homework. For situations where the array of possibilities is beyond the scope of a
course, you can hide some of the higher-level options on the Compute menu. To accom-
plish this, from the Tools menu, choose Engine Setup and check Display Simplified
Compute Menu.

This document, Doing Mathematics with Scientific WorkPlace and Scientific Note-
book, describes the use of the underlying computer algebra systems for doing mathe-
matical calculations. In particular, it explains how to use the built-in computer algebra
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system MuPAD to do a wide range of mathematics without dealing directly with the
syntax of the computer algebra system.

This document is organized around standard topics in the undergraduate mathematics
curriculum. Users can find the guidance they need without going to chapters involving
mathematics beyond their current level. The first four chapters introduce basic proce-
dures for using the system and cover the content of the standard precalculus courses.
Later chapters cover analytic geometry and calculus, linear algebra, vector analysis, dif-
ferential equations, statistics, and applied modern algebra. Exercises are provided to
encourage users to practice the ideas presented and to explore possibilities beyond those
covered in this document.

Users with an interest in doing mathematical calculations are advised to read and ex-
periment with the first five chapters—Basic Techniques for Doing Mathematics; Num-
bers, Functions, and Units; Algebra; Trigonometry, and Function Definitions—which
provide a good foundation for doing mathematical calculations. You may also find it
helpful to read parts of the sixth chapter Plotting Curves and Surfaces to get started
creating plots. You can approach the remaining chapters in any order.

Experienced MuPAD users will find it helpful to read about accessing other MuPAD
functions and adding user-defined MuPAD functions in the chapter Function Definitions.
You will also want to refer to the tables in that chapter that pair MuPAD names with
Scientific WorkPlace and Scientific Notebook names for constants, functions, and
operations.

On-Line Help

The first three items on the Help menu—Contents, Search, and Index—provide three
routes for obtaining information.

Contents To reach the Contents page, press F1 or choose Contents from the
Help menu. Choose Computing Techniques for help arranged by topic, basically an
on-line version of this manual. Once you are in a computing help document, the Next
Document links take you sequentially through all of the computing help documents—
click the right arrow on the Link Bar or choose Go + Links + Next Document. The
Next Document links also take you sequentially through the tables of contents for the
chapters of Computing Techniques.

Search For a discussion on a particular topic, choose Help + Search and enter key
words. Search will find topics in the General Information and Reference Library
indexes as well as in the Computing Techniques index.

Index For a discussion on a particular computing topic, choose Help + Index +
Computing Techniques. When you open an Index, use the drop-down list on the

Navigate bar, click the GoTo Marker button on the Navigate or History toolbar,
or choose Go + To Marker, and choose from the drop-down list that appears.

For a quick start in using Scientific WorkPlace or Scientific Notebook for text edit-
ing and computing, press F1 or choose the Contents menu under Help, and try Take
a Tour and Learn the Basics. You will also get many useful hints for computing by
working quickly through documents provided with your system on the \play subdirec-
tory. If you save copies of the Help documents in Scientific WorkPlace or Scientific
Notebook, you can interact with the mathematics they contain, experimenting with or
reworking the included examples.
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For information on the document-editing features of your system, the online Help
describes how to create transportable IATEX documents without viewing the syntax of
IATEX, how to typeset with I6TpXand PDFIATEX, and how to create HTML and RTF
output—see General Information under Contents or Index, or choose Search. These
document-editing features are also described in the document, Creating Documents with
Scientific Word and Scientific WorkPlace.

Conventions

Understanding the notation and the terms we use in our documentation will help you
understand the instructions in this manual. We assume you are familiar with basic Win-
dows procedures and terminology. In this manual, we use the notation and terms listed
below.

General Notation
o Text like this indicates text you should type exactly as it is shown.

e Text like this indicates the name of a menu, command, or dialog.

e TEXT LIKE THIS indicates the name of a keyboard key.

e Text like this indicates the name of a file or directory.

o Text like this indicates a term that has special meaning in the context of the program.
e Text like this indicates an expression that is typed in mathematics mode.

e The word choose means to designate a command for the program to carry out. As
with all Windows applications, you can choose a command with the mouse or with
the keyboard. Commands may be listed on a menu or shown on a button in a dia-
log box. For example, the instruction “From the File menu, choose Open” means
you should first choose the File menu and then from that menu, choose the Open
command. This is often abbreviated as File + Open. The instruction “choose OK”
means to click the OK button with the mouse or press TAB to move the attention to
the OK button and then press the ENTER key on the keyboard.

e The word check means to turn on an option in a dialog box.

e When Compute menu commands are specified, the word Compute is usually sup-
pressed. For example, when you see Evaluate, choose Compute + Evaluate.

Keyboard Conventions

We also use standard Windows conventions to give keyboard instructions.

e The names of keys in the instructions match the names shown on most keyboards.
They appear like this: ENTER, F4, SHIFT.

e A plus sign (+) between the names of two keys indicates that you must press the first
key and hold it down while you press the second key. For example, CTRL + G means
that you press and hold down the CTRL key, press G, and then release both keys.

e The notation CTRL + word means that you must hold down the CTRL key, type the
word that appears in bold type after the +, then release the CTRL key. Note that if a
letter appears capitalized, you should type that letter as a capital.
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Obtaining Technical Support

If you can’t find the answer to your questions in the manuals or the online Help, you can
obtain technical support from the website at

http://www.mackichan.com/techtalk/knowledgebase.html

or at the Web-based Technical Support forum at

http://www.mackichan.com/techtalk/UserForums.htm

You can also contact the Technical Support staff by email, telephone, or fax. We urge
you to submit questions by email whenever possible in case the technical staff needs to
obtain your file to diagnose and solve the problem.

When you contact Technical Support by email or fax, please provide complete in-
formation about the problem you’re trying to solve. They must be able to reproduce
the problem exactly from your instructions. When you contact them by telephone, you
should be sitting at your computer with the program running. Please provide the follow-
ing information any time you contact Technical Support:

e The MacKichan Software product you have installed.

e The version and build numbers of your installation (see Help / About).

The serial number of your installation (see Help / System Features).

The version of the Windows system you’re using.

The type of hardware you’re using, including network hardware.

What happened and what you were doing when the problem occurred.

e The exact wording of any messages that appeared on your computer screen.

To contact technical support

e Contact Technical Support by email, fax, or telephone between 8 AM and 5 PM Pa-
cific Time:

Internet electronic mail address: support@mackichan.com
Fax number: 360-394-6039
Telephone number: 360-394-6033
Toll-free telephone: 877-SCI-WORD (877-724-9673)

You can learn more about Scientific WorkPlace and Scientific Notebook on the
MacKichan web site, which is updated regularly to provide the latest technical in-
formation about the program. The site also houses links to other TgX and IXTgX re-
sources. There is also an unmoderated discussion forum and an unmoderated email
list so users can share information, discuss common problems, and contribute techni-
cal tips and solutions. You can link to these valuable resources from the home page at
http://www.mackichan.com.

Darel W. Hardy
Carol L. Walker



1 Basic Techniques for Doing
Mathematics

In this chapter, we give a brief explanation, with examples, of each of the basic computa-
tional features of Scientific WorkPlace and Scientific Notebook. You are encouraged
to open a new document and work the examples as you proceed. You can begin comput-
ing as soon as you have opened a file.

» To enter and evaluate an expression

1. From the Insert menu, choose Math. (If this choice does not appear, your insertion
point is already in mathematics mode and you are ready for step 2.)

2. Enter a mathematical expression in the document—for example, 2+2. (It will appear
red on your screen.)

3. Leaving the insertion point in the expression, from the Compute menu, choose
Evaluate.

The expression 2 + 2 will be replaced by the evaluation 2 + 2 = 4.
Mathematics is automatically spaced differently from text as you enter it—for exam-
ple, “2 + 2” rather than “2+2”—so you do not have to make adjustments.

Inserting Text and Mathematics

The blinking vertical line on your screen is referred to as the insertion point. You may
have heard it called the insert cursor, or simply the cursor. The insertion point marks
the position where characters or symbols are entered when you type or click a symbol.
You can change the position of the insertion point with the arrow keys or by clicking
a different screen position with the mouse. The position of the mouse is indicated by
the mouse pointer, which assumes the shape of an I-beam over text and an arrow over
mathematics.

Basic Guidelines

You can enter information in a document in either mathematics or text. The mathematics
that you enter is recognized by the underlying computing engine as mathematics, and
the text is ignored by the computing engine.

e Text is entered at the position of the insertion point when the Toggle Text/Math

button in the Standard toolbar shows T .
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e Mathematics is entered at the position of the insertion point when the Toggle Text/-

Math button on the Standard toolbar shows | M |.

Show/Hide
New Save Print Spelling Copy Undo Nonprinting Table
| | | | | | | |
D2 =& S|k %=el o|ala T & o 5]
| | | | | | | |
Open Open Preview Cut Paste  Properties Toggle Zoom Factor
Location Text/Math

e On the screen, mathematics appears in red and text in black. For information on
changing this, see Help + Search + Screen Defaults.

Note See the preface (page for notation and keyboard conventions used in this
manual.

You can toggle between these two states by clicking the buttons shown earlier or by
pressing CTRL + M or CTRL + T on the keyboard. Entering a mathematics symbol by
clicking a button on a toolbar automatically puts the state in mathematics at the position
in which the symbol is entered. The state remains in mathematics as you enter characters
or symbols to the right of existing mathematics, until you either toggle back into text or
move the insertion point into text by using the mouse or by pressing RIGHT ARROW,
LEFT ARROW, or ENTER. (To customize your system for toggling between mathematics
and text, from the Tools menu, choose User Setup and click the Math tab. The choices
include toggling with the SPACE BAR or the INSERT key. See Help + Search + User
Setup for further details.)

Choose Help + Search + toolbars + customizing the toolbars, if the Math Tem-
plates toolbar referred to below—or any other toolbar you would like to use—does not
automatically appear on your screen.

» To enter a fraction, radical, exponent, or subscript

O ™
1. Click on | |, ‘1"E , N , or Nx on the Math Templates toolbar.

or

From the Insert menu, choose Fraction, Radical, Superscript, or Subscript.

or

Press CTRL + F, CTRL + R, CTRL + H (or CTRL + UP ARROW), or CTRL + L (or
CTRL + DOWN ARROW).

2. Enter expressions in the input boxes.

The SPACEBAR and ARROW keys move the insertion point through mathematical
expressions and the TAB key toggles between input boxes.
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» To use various symbols for multiplication and division

e Click your choice on the Symbol Cache toolbar.

e l=le]-lelvlal<]elc]n]vl]-]e]-]"]

or

7| on the Symbol Panels toolbar

e Click the Binary Operations button |

o | 0% |+ ¢ | cc|ee|at =8| o0 | £2] 22| 7

and choose from symbols on the drop-down panel:

l;

+ F ES . =
L B @ - -
[ B I N
TlS|@| 2| ®
MA@ 4] E
L P IR I
wl w4 &
Ylale|t]|*
H|B|&|O|@
Wt fes | | >
WAl Rl A|T
+ | 2| & I
&

or
e Use * and / on the keyboard.

You select a piece of text with the mouse by holding down the left mouse button
while moving the mouse, or from the keyboard by holding down SHIFT and pressing
RIGHT ARROW or LEFT ARROW. Your selection appears on the screen in reversed colors.
This technique is sometimes referred to as sighlighting an area of the screen. This is also
one of the ways you can select mathematics. See page 9] for a discussion of automatic
and user selections for mathematics.

There is a variety of brackets available for mathematics expressions. Brackets en-
tered from buttons or dialogs, or from the keyboard with CTRL pressed, are expanding
brackets (sometimes called fences)—both sides are entered and the resulting brackets
change size (both height and width) depending on the contents. Expanding brackets will
not break at the end of a line so lengthy expressions enclosed in expanding brackets may
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need to be displayed. Left and right brackets entered from the keyboard (without CTRL
pressed) act independently. They also have fixed height.

» To enter brackets in a mathematics expression

o Click 10} or | [ on the Math Templates toolbar.

or

e Choose Insert + Brackets or click the Brackets button [][] on the Math Objects
toolbar, and choose Left and Right brackets from the Brackets dialog.

Brackets E3 |

o]
( } Cancel |

[0 mCmAN T8 e MBI LI

Right:

PIERADINANEE YU OO

or

e Press CTRL + 9 or CTRL + [ or CTRL + SHIFT + [ on the keyboard for expanding
brackets.
or

e Type the appropriate keyboard symbols in mathematics.

Tip The appearance of the Toggle Text/Math button — M| or T — reflects
the state at the position of the insertion point.

Displaying Mathematics

Mathematics can be centered on a separate line in a display.
y=ax+b

» To create a display

1. Click or, from the Insert menu, choose Display, or press CTRL + D.
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2. Type a mathematical expression in the display, or select a piece of mathematics and
drag it into the display.

You can begin with an existing mathematical expression and put it into a display.

» To put mathematics in a display

1. Select the mathematics with click and drag or SHIFT+RIGHT ARROW.

2. Click the Display button on the Math Objects toolbar, or from the Insert menu,
choose Display.

The default environment in a display is mathematics. You can, however, enter text in
a display by toggling to text. Also, you can select mathematics or text in a display and
change its state by toggling (see page[2).

Note Pressing ENTER immediately before a display will add extra vertical space. If
you do not want this space, place the insertion point immediately before the display and
press BACKSPACE. (This removes the “new paragraph” symbol.)

Pressing ENTER immediately after a display will add extra vertical space and
cause the next line to start a new paragraph. If you do not want this space or indention,
place the insertion point at the start of the next line and press BACKSPACE. (This removes
the “new paragraph” symbol.)

Centering Plots, Graphics and Text

If you have text that you wish to center on a separate line, the natural way to do this
operation is with Centered, which you can choose from the Section/Body Tag pop-up
menu at the bottom of your screen.

If you have a plot or graphic that you wish to center on a separate line, you should
choose the Display setting in the Layout dialog, as discussed in Chapter [6] Plotting
Curves and Surfaces. To center a group of plots or graphics, choose the In Line setting
in the Layout dialog and use Centered. We generally advise against placing a plot
inside the Insert + Display object, as this makes the plot itself a mathematical object,
which can sometimes cause difficulties.

Basic Guidelines for Computing

When you respond to the request “place the insertion point in the expression,” place
the insertion point within, or immediately to the right of, the expression. The position
immediately to the left of a mathematical expression is not valid. You can check the state
of the Toggle Text/Math button to verify that your insertion point is in mathematics or
text.

Evaluating Expressions



6

Chapter 1 Basic Techniques for Doing Mathematics

To enter a mathematics expression for a computation, begin a new line with the mathe-
matics expression or type the expression immediately to the right of text or a text space.
If you enter mathematics immediately to the right of other mathematics, the expressions
will be combined in ways you may not intend. A safe way to begin is to press ENTER
and start on a new line.

To add 3 and 8

1. Click T (or choose Insert + Math, or press CTRL + M) to toggle to mathematics

mode, so that the Text/Math button looks like M.

2. Type 3+ 8.

3. Leaving the insertion point in the expression 3 + 8, do one of the following:

e Click the Evaluate button =? on the Compute toolbar.

or
e From the Compute menu, choose Evaluate.

or
o Press CTRL + E.

This sequence of actions inserts = 11 to the right of the 3 + 8, resulting in the equation
3+8 =11

By following the same procedure, you can carry out the following operations and
perform a vast variety of other mathematical computations.

Note The contents of the gray boxes (shaded background) display the mathematical
expressions you enter, together with the results of the indicated operation. In general,
throughout this document, the mathematical contents of gray boxes display both the
input for an action and the results. In the case of plots, the input is displayed in the gray
box and the results are displayed immediately following the gray box.

Add

Evaluate

235 + 813 = 1048 49.3 + 2.87 = 52.17
2 1 17

3t==35 (z+3)+(z—y) =2c—y+3

Subtract

» Evaluate
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96 — 27 = 69 (222 —5) — 3z +4) =222 — 3z — 9
2 8 10
49.3 — 2.87 = 46.43 Ao o
Multiply
Evaluate
82 x 37 = 3034 (936) (—14) = —13104
28 16
14.2 % 83.5 = 1185. So==
% 83.5 85.7 0= o
Divide
Evaluate
82 18
8237 = — 36/ =
14.2 -2 7
S35 = 017006 T

Important Except that it be mathematically correct, there are almost no rules about
the form for entering a mathematical expression in Scientific WorkPlace and Scientific
Notebook.

For example, the expressions

2 8

, 2 8
A TNk

are equally acceptable ways of entering a quotient of fractions. Also,
(936) (14) 936-14 936 x 14 936 * 14

and many other variations are acceptable for the same product. One of the few excep-
tions to the claim of “no rules” is that “vertical” notation such as

_&151 and _22? and 2)364
used when doing arithmetic by hand is not generally recognized. Write sums, differ-
ences, products, and quotients of numbers in natural “linear” or fractional notation, such
as 24 + 15 and 235 — 47 and 36 x 14 and 364/2 or % or 364 + 2.

Certain constants are recognized in their usual forms—such as 7, ¢, and e—as long as
the context is appropriate. On the other hand, they are recognized as arbitrary constants,
variables, or indices when appropriate to the context, helping to provide a completely
natural way for you to enter and perform mathematical computations.

~tloo|eolro

Note The number of digits in answers to numerical problems depends on settings that
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you can change in the Tools + Computation Setup dialog discussed on page The
examples in this document may differ in this respect from the answers you get with your
system, and different examples in this document use different settings.

Interpreting Expressions

If your mathematical notation is ambiguous, it may still be accepted. However, the way
it is interpreted may or may not be what you intended. To be safe, remove an ambiguity
by placing additional parentheses in the expression.

To check the interpretation of a mathematical expression

1. Leave the insertion point in the expression.

2. Press CTRL, and while holding it down, type ?
or

Choose Compute + Interpret.

CTRL + ?

1/3z+4=1z+4 1/ Bz +4) = @y
1/(Bz) +4=4+ +4 1/3(x+4) =1 (z+4)

Tip Although in most cases different shapes of brackets are interchangeable, as a gen-
eral rule standard parentheses (3 + 7) are better for grouping mathematical expressions
than other types of brackets, because in a few very special cases, other brackets can
be interpreted in a way you don’t intend. Also, the expanding brackets you enter from
the Insert menu or the Math Templates toolbar or with various keyboard shortcuts are
generally better for grouping mathematical expressions than the single brackets on the
keyboard.

The Compute Menu and Toolbar

Click Compute at the top of the screen and a drop-down menu will appear with a num-
ber of computing choices, beginning with Evaluate, Evaluate Numerically, Simplify,
Combine, Factor, and Expand.

The Compute toolbar contains some of the most often used choices from the Com-
pute menu.
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Solve Plot 3D Show
Evaluate Exact Expand Rectangular Definitions

\ \ \ \ \
=2|22| 2| =5 @| 4| oilw
\ \ \ \
Evaluate  Simplify  Plot 2D New
Numerically Rectangular Definition

» To perform a mathematics computation

1. Place the insertion point inside or to the right of the expression on which you want
to perform an operation.

2. Click the button or menu item for the operation you want to perform.

Important Throughout this document, whenever computing commands are specified,
the preceding Compute is implied. For example, when you see Evaluate, choose Com-
pute + Evaluate.

Commands on the Compute menu can be executed from the keyboard following
standard procedures.

» To execute a command on the Compute menu from the keyboard

e Press ALT and, while holding down this key,
e Press € (for Compute), followed by the command letter underlined on the drop-
down menu that appears.

e [f the command is followed by an arrow on the right of the menu, press ENTER
followed by another underlined command letter.

Some commands have a shorter keyboard shortcut. (CTRL + KEY is an abbreviation
for “Press CTRL and, while holding down this key, press KEY.”)

Shortcut Command

CTRL + E Compute + Evaluate

CTRL + SHIFT + E Compute + Evaluate (in-place replacement)
CTRL + = Compute + Definitions + New Definition

There are many other keyboard shortcuts available. For a list of keyboard shortcuts
for both mathematics and text, choose Help + Search + keyboard shortcuts and, from
the list, choose keyboard shortcuts.

Selecting Mathematical Expressions

When you perform a mathematical operation, a mathematical expression is automati-
cally selected for the operation, depending on the position of the insertion point and the
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operation involved. We will refer to these as automatic selections. You can also force
other selections by selecting mathematics with the mouse. We will refer to the latter as
user selections.

Understanding Automatic Selections

When you place the insertion point in a mathematical expression and choose an opera-
tion from the Compute menu, the automatic selection depends primarily on the com-
mand you choose. It also depends on the location of the mathematics, such as in-line, in
a matrix, or in a display. The following two possibilities occur for mathematical objects
that are typed in-line:

e Selection of an expression, that part of the mathematics containing the insertion point
that is enclosed between a combination of text and the class of symbols—such as =,

<, or < —known as binary relations. (Click 25| onthe Symbol Panels toolbar
to see the full selection of binary relations.)

e Seclection of the entire mathematical object, such as an equation or inequality.

Examples in the following two sections illustrate situations where these two types of
selections occur.

Operations that Select an Expression

The majority of operations select an expression enclosed between text and binary opera-
tions. Place the insertion point anywhere in the left side of the equation 2z + 3z = 1+4
except to the left of the 2, and choose Evaluate.

Evaluate
20 +3z=>5xr=1+4

The expression = 5z is inserted immediately after the expression 22+ 3z. This time,
only the expression on the left side of the equation was selected for evaluation. Since the
result of the evaluation was equal to the original expression, the result was placed next
to the expression, preceded by an equals sign. The insertion point is placed at the right
end of the result so that you can select another operation to apply to the result without
moving the insertion point.

Other commands, including Evaluate Numerically, Simplify, Combine, Factor,
and Expand, make similar selections under similar conditions.

Operations that Select an Equation or Inequality
Place the insertion point anywhere within the equation 2z + 3z = 1 and click the Solve

button X? on the Compute toolbar or, from the Solve submenu, choose Exact.

» Solve + Exact
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2 + 3z = 1, Solution is: #

3z + 5 < 5z — 3, Solution is: [4, 00)

In these cases, the entire mathematical object—that is, the equation or inequality—
was selected. The other choices on the Solve submenu and the operation Check Equal-
ity also select the entire mathematical object.

If the mathematics is not appropriate for the operation, no action is taken or no
solution is found. For example, applying one of the Solve commands to x = y = 2
causes a syntax error, because of the pair of equals signs. You receive the message “No
solution found.” For other inappropriate mathematics, you may see an error message,
hear a beep, or see no action, depending on the Error Notification setting. You can
change this setting in the Engine Setup dialog on the Tools menu (see page|[15).

Selections Inside Displays and Matrices

Operations may behave somewhat differently when mathematics is entered in a display
or in a matrix. If you place the insertion point inside a display or matrix, the automatic
selection is the entire array of entries, for any operation. Some operations apply to a
matrix, and others to the entries of a matrix or contents of a display. If the operation is
not appropriate for either a matrix or its entries or for all the contents of a display, you
may receive a report of a syntax error.

Inside a display, the automatic selection is a/l the mathematics, and the result is
generally returned outside the display. To select mathematics in a display, place the
insertion point anywhere inside the display, and choose a command that operates on
expressions or equations.

When you click =? or apply Evaluate with the insertion point in the left side of
the displayed equation

20 +3x=3+5
you get the result : 5z = 8 in-line outside the display. Because the automatic selection
includes all of the mathematics, this action evaluates both sides of the equation.
A multiple line display is useful for solving systems of equations, or equations with
initial value conditions.

Solve + Exact

, Solution is: [z = %734 - _%]

You can use a matrix to arrange mathematical expressions in a rectangular array. To

create a matrix, choose Matrix from the Insert menu or click |=g2], set the number of

rows and columns, and choose OK. If you see nothing on your screen, choose View and
turn on Hidden Lines or Input Boxes. Type a number or mathematical expression in
the input boxes of the matrix.
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When you click =? or apply Evaluate to a matrix of expressions, all the expres-
sions will be evaluated and the result will be returned as a matrix. Evaluate Numeri-
cally, Simplify, Factor, and choices from the Combine submenu behave similarly.

Evaluate (or Simplify)
z+x 5+3 )\ [ 2z 8
5/2 62 ) 2 36

Evaluate Numerically
z+x 5+3 _ 2.0z 8.0
5/2 62 ~\ 25 360
Factor

z+z 5+3\ [ 2z 23
52 6% )\ 5 2232

Selections Inside Tables

A table is not a mathematical object, and the behavior for mathematics inside a table is
somewhat different than for mathematics in a matrix or display. If you have mathematics
in a table, placing the insertion point in the mathematics will automatically select all of
the mathematics in the cell that contains the insertion point. For example, Evaluate
will select an equation if one is present, rather than just an expression. The result of the
operation will appear in the cell.

Understanding User Selections

You can restrict the computation to a selection you have made and so override the auto-
matic choice. Recall that you can select a piece of mathematics by holding down the left
mouse button while moving the mouse; your selection is the information that appears on
the screen in reversed colors.

There are two options for applying operations to your selection—operating on a
selection displays the result of the operation but leaves the selection intact, and replacing
a selection replaces the selection with the result of the operation. Following are two
examples illustrating the behavior of the system when operating on a selection. The
option of replacing a selection is referred to as computing in place, and examples are
shown in the next section.
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» To operate on a user selection

1. Use the mouse or press SHIFT + ARROW to select an expression.

2. Applying a command to the expression.

Example Use the mouse or press SHIFT + ARROW to select 2 + 3 in the expression
2+ 3 — z. From the Compute menu, choose Evaluate. The answer appears to the right
of the expression, following a colon (:).

24+3—-x:5
Use the mouse or press SHIFT + ARROW to select (z + y)* within the expression
(z +y)° (7 — 13y)® 4 sin? 2. From the Compute menu, choose Expand. The answer
appears to the right of the whole expression, following a colon.

(z+y)* (T2 — 13y)® + sin® z : 2° + 322y + 32y® + ¢°

In general, the result of applying an operation to a user selection is not equal to the
entire original expression, so the result is placed at the end of the mathematics, separated
by something in text (in this case, a colon). You can then use the word-processing
capabilities of your system to put the result where you want it in your document.

» To replace a user selection

1. Use the mouse or press SHIFT + ARROW to select an expression.

2. Press and hold CTRL while applying a command to the expression.
or

For the command Evaluate, press CTRL + SHIFT + E.

The system replaces the selected expression with the output of the command. This is an
in-place computation, as described in the following section.

Computing in Place

With the help of the CTRL key, you can perform any computation in place; that is, you
can replace an expression directly with the results of that computation. This “computing
in place” is a key feature. It provides a convenient way for you to manipulate expressions
into the forms you desire.

Select with the mouse the expression that you wish to replace, and while holding
down the CTRL key, choose the desired operation from the Compute menu. The re-
sponse that replaces the original expression will remain selected, making it convenient
to add parentheses around the new expression when needed simply by clicking the paren-
theses button.

» Select expression and choose CTRL + Evaluate or choose CTRL + SHIFT + E

2/3 is replaced by % 146 + 529 — 19 + 6 is replaced by 662
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» Select expression and choose CTRL + Expand

2345/567 is replaced by 45% (a + b)3 is replaced by a® + 3a%b + 3ab® + b3

This feature, combined with copy and paste, allows you to “fill in the steps” in
demonstrating a computation.

Example To replace (x — 2y)” in the expression (z — 2y)* (72 — 13y) (2% + 1) with

its expansion, select (z — 2y)2, hold down the CTRL key, and click a'- or choose

Expand. Your selection, (x — 2y)2, is replaced by its expansion. The expansion has

no parentheses around it, but since it remains selected, you can click [D:I to add the
needed parentheses. Following this procedure,

(z —2y)* (Tz — 13y) (z®+1)

is replaced by
(2% — 4oy + 4y%) (T — 13y) (2* + 1)

You can return the expression to a factored form by selecting (2% — 4zy + 4y?), holding
down the CTRL key, and choosing Factor.

Stopping a Computation

Most computations are done more or less instantaneously, but some may take several
minutes to complete, and some may take a (much) longer time. So it is convenient to be
able to interrupt the computing and regain control of your document.

To stop a computation

e Click the stop sign @ on the Stop toolbar.
or

e Press CTRL + BREAK.

Computational Engine

The computational engine provided with Scientific WorkPlace and Scientific Note-
book Version 5.5 is MuPAD 3.1. To see if this engine is active in your system, or to
deactivate the engine, choose Tools + Computation Setup + Engine Selection.

For a list of menu commands, a partial list of functions and constants available,
and a description of these commands and functions in terms of the native commands
of MuPAD, see page or go to Help + Search + function and choose a brief
description of commands and functions.
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Error Handling

From the Tools menu, choose Engine Setup and click the Error Handling tab. On this
page you can specify the default settings for Error Notification, Engine Command
Notification, and Transaction Logging.

Under Error Notification you can choose None, choose to be notified with Beep,
or choose Message to Status Bar or Message to Dialog Box. These are responses
to various syntax errors in the mathematics being sent to the computing engine. If you
choose to have messages shown, you will see some information concerning these errors.

Under Engine Command Notification, you can choose None, or choose Show
Commands on Status Bar or Show Commands in Dialog Box. If you choose to
have commands shown in a dialog box, you will see the syntax of commands being sent
to the computing engine.

MuPAD Settings

General  Emar Handling

Errar Matification————— 1~ Engine Cammand Matification
" Mane * Mane

" Show Commands on Status Blar
" Message to Status Bar

" Message to Dialog Box £ Show Commands in Dialog B ox

— Tranzaction Logging

™ Emor Messages Sl Loee e I
™ Strings to Engine

Stop [Legaihg I
[ Strings from Engine
[ Message Times Llear Log File

Beset Page to Default: I

] I Cancel |

The factory defaults for these choices are those shown in the graphic.
e Error Notification: Beep

e Engine Command Notification: None.

e Transaction Logging: None
To return to these defaults, choose Reset Page to Defaults and choose OK.

Under Transaction Logging, you can choose to have some, all, or no records of
mathematical messages sent to the computing engine recorded in an ASCII log file.
Transaction Logging always resets to the default of not logging. To accumulate entries
in the log file, you must take the following action each time you open a session.
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» To start logging transactions

1.

2.

From the Tools menu, choose Engine Setup, and click the Error Handling tab.

Choose Start Logging.

. Check any or all of the choices for Transaction Logging: Error Messages, Strings

to Engine, Strings from Engine.

. If you want the times recorded in the log file, check Message Times.

. Choose Start Logging and choose OK.

With Start Logging activated, your system will create a file named engine.log

on the root directory of your Scientific WorkPlace or Scientific Notebook system, and
record all of your transactions in this file for the rest of the session or until you press
Stop Logging. The transactions you have logged will be saved in this file until you
choose Clear Log File. You can read the file engine. 1og with any ASCII editor.

Frequently Asked Questions

Here, in question and answer form, are some situations that might arise when you are
working in a document.

Q.

A.

My screen has gotten cluttered with lines or marks that don’t belong there (or I can’t
see something on the screen that I know is there). What can I do?

Press ESC or choose View + Refresh to refresh your screen.

What can I do if I type an expression in text mode that I meant to have in mathematics
mode?

Select the expression with the mouse or select the expression from the keyboard by
placing the insertion point to the left of the expression and pressing SHIFT + RIGHT

ARROW. Then click the Toggle Text/Math button T to change it to M|

What can I do if I cannot see all of my work on the screen either horizontally or
vertically?

If a piece of mathematics extends beyond the width of the screen, you can scroll
horizontally using the scroll bars at the bottom of the screen. If the mathematics has
possible breaking points, add an Allow Break at appropriate places from the Insert
+ Spacing + Break menu. To see more of your document on the screen at a time,
you can reduce the size of the screen font. Click View and choose Working. Change
the percentage in the Working View box and choose OK. The 1x on the View menu
gives 100% and the 2x gives 200%. The range for Working View is 50% (very
small) to 400% (huge).

Can I change the behavior of the SPACEBAR, ENTER, and TAB keys?
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A setting on the Edit page of Tools + User Setup will allow you to change these
behaviors. The default behavior allows you to enter multiple spaces, horizontal or
vertical, by pressing SPACEBAR, ENTER, or TAB. Follow directions on the menu
to change spacing behaviors. For a variety of spacing options, choose Insert +
Spacing + Horizontal Space or Vertical Space, and choose an appropriate size
space. If you check Custom Space, you can specify the width or height of the
space or choose stretchy spaces. Mathematics is automatically spaced appropriately
for most situations. To keep a mathematical expression meaningful for computation,
be sure any added space stays in mathematics mode.

I tried a computation and nothing happened (although my system does carry out
other computations). How can I find out what I did wrong?

One common problem is a forgotten definition. Choose Compute + Definitions +
Show Definitions and look for a definition that is interfering with your computation.
Apply Compute + Definitions + Undefine to the variable or function that is causing
the problem. If this does not solve the problem, click Tools, choose Engine Setup,
Error Handling page, and change the setting for Error Notification. With a setting
of None, you get no response to errors. With a setting of Beep, you get a warning
sound with an error. With other settings, you get messages with information about
the error—usually the error message generated by the computing engine. (See page
for more detailed information about error handling.)

I tried to take the absolute value of an expression and nothing happened. What is
wrong?

The symbols for absolute value are the vertical lines from the dialog box under

Brackets [][] . (The keyboard vertical line will also work, but expanding brackets
are less vulnerable to misinterpretation.) Perhaps you used the vertical lines from

the symbol panel under the Binary Relations button |£%|. Although they appear
similar, they are not the same symbols and will not be interpreted as absolute-value
symbols.

How can I be sure exactly how my mathematical expression is being interpreted?

Select the expression and press CTRL + ? or choose COMPUTE + INTERPRET. The
expression will be presented in an unambiguous form. For example,
. . sina . LT
sina/sinb = — sinx/y = sin — /xy:/xyd?
sin b y
Add parentheses or change the expression some other way to remove an ambiguity.

. The mathematics I entered is being misinterpreted but it looks okay on the screen.
What should I change?

Is your expression in a display? If you place the insertion point in a display and
choose Evaluate, the entire contents of the displayed object will be evaluated, even if
part of it is text. To avoid this type of behavior, select the expression or equation with
click and drag before choosing a command. If you are using braces, square brackets,
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e

or non-expanding parentheses in place of expanding parentheses, try changing all of
these to expanding parentheses. It is advisable, as a general rule, to use expanding
parentheses whenever parentheses are called for. For a variety of reasons, other
choices for brackets are vulnerable to misinterpretation—particularly if the left and
right parentheses do not match. Example: (2)(3) is entered with the outer parenthe-
ses “()” expanding brackets and the inner parentheses ) (” non-expanding parenthe-
ses. Evaluating this non-matched expression gives (2)(3) = 2, which is probably
not what is intended! Although the expanding brackets under the Brackets button

[][] , the expanding brackets [D:I and [[] , and non-expanding brackets from
the keyboard are generally interchangeable (when properly matched), there are a few
circumstances in which the square brackets or keyboard brackets or even keyboard
parentheses do not work properly. In particular, the less-than and greater-than sym-
bols on the keyboard should not be used as brackets. These two symbols, as well as

the symbols on the panel under 251 are binary relations and generally will not be
interpreted as brackets. Square brackets and braces have some special meanings for
the computing engine, and even though the interface is designed to accept as many
ordinary mathematics expressions as possible, the use of nonexpanding or unusual
brackets can lead to misinterpretations.

My expression will not plot. What can I try?
Choose Compute + Definitions + Show Definitions, or click the Show Defini-

tions button on the Compute toolbar, and look to see if any of the variables
you are using are defined. If so, select the variable and choose Compute + Defini-
tions + Undefine. If a forgotten definition is not the problem, hold down the CTRL
key while giving the plot command. This will cause the Plot Properties dialog to
come up before the system makes the plot. Choose the ltems Plotted page and try
changing the settings for Variables and Intervals and/or uncheck the Adjust Plot
for Discontinuities option.

My document contains complicated plots, and scrolling through the document is very
slow. Can I turn off the plots temporarily to save myself time as I edit the file?

You can turn off the computing engine temporarily: choose Tools + Computation
Setup, go to the Engine Selection page, and choose None. If you want to keep the
computing engine active, you can set the plot either to appear on the screen as an icon
or as an empty frame: select the plot, choose Edit + Properties, and on the Layout
page, under Screen Display Attributes, check Iconified or check Frame Only. If
you choose Iconified, you can enter a Name for the icon on the Labeling page of
the Plot Properties dialog. Or, if your plots are in final form, you can rename the
plot snapshots and import them as pictures that take much less time to load. See page
for details on this option.



2 Numbers, Functions, and
Units

Numbers and functions to be used for computing should be entered in mathematics mode
and appear red (or gray) on your screen. If that is not the case, select the expression and

click T to change it to mathematics. Units to be used for computing must be entered
as a Unit Name (see page[43).

» To enter a mathematics expression for a computation

e Begin a new line with the mathematics expression.
or

e Type the expression immediately to the right of text or a text space.

Note If you enter mathematics immediately to the right of other mathematics, the
expressions will be combined in ways you may not intend. A safe way to begin is to
press ENTER and start on a new line.

Integers and Fractions

The first examples are centered around rational numbers—that is, integers and fractions.
You will find examples of many of the same operations later in this chapter, using real
numbers and then complex numbers. Similar operations will be illustrated in later chap-
ters with a variety of different mathematical objects.

Addition and Subtraction

» To add 3, 6, and 14

1. To put the insertion point in mathematics mode, do one of the following:
e Choose Insert + Math. (If you see Text on the Insert menu, you are already in
mathematics mode.)

e Click the Text/Math button | I | on the Standard toolbar. (If you see | M
on the toolbar, you are already in mathematics mode.)

e Press CTRL + M.
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2. Type 3 + 6 + 14 (This expression should appear red on your screen.)

3. Leaving the insertion point in the expression 3 4+ 6 + 14, do one of the following:
e From the Compute menu, choose Evaluate.

e Click the Evaluate button =? on the Compute toolbar.
e Press CTRL + E.

This sequence prompts the system to insert = 23 to the right of the 3 4 6 + 14, resulting
in the equation 3 + 6 + 14 = 23.

By following the same procedure, you can carry out subtraction and perform a vast
variety of other mathematical computations. With the insertion point in the sum (or
difference), choose Evaluate.

» Evaluate

235 + 813 = 1048 282 96 — 2742 =171

Note Following a command, the mathematical contents of gray boxes (the shaded ar-
eas on these pages) display the mathematical expressions you enter, together with the
results of the indicated command. In general, throughout this document, the mathemat-
ical contents of gray boxes display both the input for an action and the results.

» To obtain the fraction template

e Place the insertion point in the position where you want the fraction, and
e Choose Insert + Fraction.
or
e Click the Fraction button on the Math Templates toolbar.
or
e Press CTRL + F or CTRL +/ or CTRL + 1.
The template will appear with the insertion point in the upper input box, ready for

you to begin entering numbers or expressions. Choose View and check Input Boxes to
see input boxes on the screen.

Multiplication and Division

Use any standard linear or fractional notation for multiplication and division, and with
the insertion point in the product (or quotient), choose Evaluate

» Evaluate

16 x 37 = 592 (84) (—39) = —3276 2%
_2
103 + 37 = 32 8.2/3.7 = 2.2162 = =—15
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Mixed Numbers and Long Division

A number written in the form 14% is interpreted as the mixed number 14 + g. Most
commands applied to a mixed number return a fraction. For example, applying Evaluate
or Simplify to 143 gives the result 131, The reverse is accomplished by Expand, which
converts a fraction to a mixed number. These commands are also available directly on
the Compute toolbar:

L
e Click =? for Evaluate, |=2x| for Simplify, and & for Expand.

Evaluate or Simplify

2 _ 5 87 __ 18229 2 3 __ 53
15=3 19351 = 51 I5+27=1%
Expand

18229 __ 87 53 __ 5

51 = 19351 T =41

The expansion of a fraction to a mixed number uses the familiar long-division algorithm.
In the preceding example, 18229 divided by 94 is equal to 193 with remainder 87.

Elementary Number Theory

The arithmetic of positive integers exhibits many interesting properties. Many of these
properties are related to integers called primes.

Prime Factorization

An integer greater than 1 is a prime if it is not evenly divisible by any positive integer
except 1 and itself. The list of primes begins with 2,3,5,7,11,13,17,.... Every posi-
tive integer greater than 1 can be factored into a product of powers of primes. You can
identify a prime by the fact that it is its own prime factorization.

To factor integers into products of powers of primes, place the insertion point inside
the number and choose Factor.

Factor
12345 = 3 x 5 x 823 82723 = 82723
473364564 31063 80000 = 2°310547311213 x 17 x 19 x 23

Alternately, while in mathematics, type factor (it will automatically turn gray), en-
ter the integer (with or without parentheses), and choose Evaluate.

» Evaluate
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factor (12345) = 3 x 5 x 823 factor (82723) = 82723
factor (4733 64564 31063 80000) = 2530547311213 x 17 x 19 x 23

You can use Simplify or Evaluate to return any of the preceding factorizations to
integer form.

Greatest Common Divisor and Least Common Multiple

The greatest common divisor of a collection of integers is the largest integer that evenly
divides every integer in the collection.

» To find the greatest common divisor of a collection of integers

1. Type gcd in mathematics. (The name ged should turn gray when you type the d.)

2. Enclose the list of numbers, separated by red commas, in brackets.

3. Leave the insertion point in the list, and click =? or choose Evaluate or press
CTRL + E.

» Evaluate

ged(35,15,65) = 5 ged (910, 2405, 5850, 2665) = 65 ged (104,221) = 13

Note If you enter the function ged from the keyboard while in mathematics mode,
the gc appears in red italics until you type the d, then the function name gcd changes to
a gray, nonitalic gcd. The function ged is automatically substituted for the three-letter

sequence g, ¢, and d. You can also choose gcd from the dialog that appears when you
1y
click [®@3 or when you choose Insert + Math Name.

The least common multiple of a collection of integers is the smallest positive integer
that is evenly divisible by every integer in the collection. To find the least common mul-
tiple of a collection of integers, evaluate the function lem applied to the list of numbers
enclosed in brackets and separated by commas. Leave the insertion point in the list and
choose Evaluate.

» Evaluate
lem (24, 36) = 72 lem (35, 15,65) = 1365

You can enter the function lem from the keyboard while in mathematics mode. It
changes to gray, nonitalic letters on your screen. (If it does not appear on the function
list under Insert + Math Name, you can add it to the list by typing it in the Name box
and choosing Add.)
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You can also determine both the greatest common divisor and least common multiple
by inspection after applying Factor to each of the numbers in the list.

Factorials

Factorial is the function of a nonnegative integer n denoted by n! and defined for positive
integers n as the product of all positive integers up to and including n

nl=1x2x3x4x---xXn

and for zero by
0l=1
You can compute factorials with Evaluate.

» Evaluate

31=6 7! = 5040 10! = 3628800

Binomial Coefficients

An expression of the form a + b is called a binomial. The formula that gives the expan-
sion of (a + b)" for any natural number 7 is

- n!
b no__ n—k:bk
(a+b) kzzok!(n—k)!a

This is the same formula that gives the number of combinations of n things taken k at a
time. The coefficients k,(#lk), that occur in this formula are called binomial coefficients.
These coefficients are often denoted by the symbols (Z) or Cy, i, or ,C}. Use the symbol
(2) to compute these coefficients.

» To enter a binomial coefficient (})

1. Click the Binomial button {g} on the Math Objects toolbar, or choose Insert +
Binomial.

2. Choose None for line and choose OK.

3. Type numbers in the input boxes.

» Evaluate

5 35
=10 = 6724520

You can use the Rewrite command to change a symbolic binomial to a factorial
expression.
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» Rewrite + Factorial

WEEE = (R T

Real Numbers

The real numbers include the integers and fractions (rational numbers), as well as irra-
tional numbers such as v/2 and 7 that cannot be expressed as quotients of integers.

Reminder Numbers used in computing must be entered in mathematics mode and
appear red on your screen (or another color that you have specified). If that is not the

case, select each number, or combination of numbers, and click (or choose Insert
+ Math) to convert to mathematics.

Basic Operations

The result of applying Evaluate to a combination of integers and fractions will be a
fraction. However, if any of the components of a combination of numbers is written
in floating point form—that is, with a decimal—the result will be in decimal notation.
Symbolic real numbers such as v/2 and 7 will retain symbolic form unless evaluated
numerically. To evaluate the following expressions, place the insertion point in or im-
mediately to the right of the mathematical expression you want to evaluate, then choose
Evaluate or Evaluate Numerically.

Evaluate (or CTRL + E)

9.6mr — 2.7m = 6.9 42(3+1)vV2=34/2

Evaluate Numerically

9.6m — 2.7m = 21.677 42 (% +7) V2 =48.083
To evaluate an expression and replace it with its value, press CTRL + SHIFT + E; or

select the expression with the mouse or with SHIFT + ARROW, then press and hold CTRL
and choose Evaluate.

CTRL + Evaluate (or CTRL + SHIFT + E)

235.3 4+ 813 will be replaced by 1048. 3

CTRL + Evaluate Numerically
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42 (2 + 1) V2 will be replaced by 48. 083

You can control the number of decimal places returned by Evaluate Numerically in
the Tools + Computation Setup and Compute + Settings dialogs (see page[29).

To change a floating point number to a rational number, use Rewrite from the Com-
pute menu.

Rewrite + Rational

0.125 = § 4.72=18 6.97 = B 3.1416 = 3921

To change a rational number or a symbolic number to a floating point number, use
Rewrite from the Compute menu.

Rewrite + Float

1 118 69 3927
1=0.125 U8 — 472 897 = 21.677 3921 — 3.1416

Typing float while in mathematics gives the grayed function float. Evaluating float
at a rational number gives the floating point form of the number.

Evaluate

float (§) = 0.125 float (L2) = 4.72

Powers and Radicals
To raise numbers to powers, use common notation for powers and apply Evaluate.

To obtain the radical template

e Place the insertion point in the position where you want the radical, and
e Click the Radical button on the Math Templates toolbar.
or

e Choose Insert + Radical.
or

o Press CTRL + R or CTRL + 2.

The template will appear with the insertion point in the input box, ready for you to
begin entering numbers or expressions.
To see input boxes on the screen, choose View and check Input Boxes.

To obtain the superscript (subscript) template,
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e Place the insertion point in the position where you want the superscript (subscript),
and
e Choose Insert + Superscript (Subscript).
or

e Click the Superscript button (Subscript button ) on the Math
Templates toolbar.

or
e Press CTRL + H or CTRL + UP ARROW or CTRL + 3 (CTRL + L or CTRL + DOWN
ARROW or CTRL + 4).

The template will appear with the insertion point in the upper input box, ready for
you to begin entering numbers or expressions.
To see input boxes on the screen, choose View and check Input Boxes.

» Evaluate
3t =81 374 =& V2.34 = 1.5297 (2.5)% = 2.0814
32 4 7 _
(%) = 232 8306423?3593% 622?6628 90625 0.4%% = 1.844 674407 x 10~ 13

Note that Evaluate returns a different answer for (%)32 and (0.4)**. The fraction

. 32, . .
displayed for (2)™ is the exact answer, and the number displayed for (0.4)*” is the best
10-digit approximation to the exact answer. The exponential and radical notation can
evoke different responses for roots of real numbers.

Radical notation for roots

Evaluate and Simplify will compute real roots of positive real numbers written in either
symbolic or floating point notation, and will compute complex odd roots of floating
point numbers (see page [39). The result of either of these operations is presented in
symbolic or floating point notation according to the form of the input. Evaluate and
Simplify produce the same result from floating point numbers. Sometimes Simplify is
useful with symbolic numbers.

» Evaluate
v/0.008 = 0.2 V24 =26 972 = 3 o168 — 1976

V16 =2 V-8 =-2 v18.234 = 1.7872 v/—18.234 = —1.7872
» Simplify

Jr=293  Vi6ar® =3¢/
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You can also Evaluate the built-in function simplify(expression). (Type simplify in
mathematics mode and it will automatically turn gray.)

Evaluate

simplify ( ¥ —%) =-2J2 simplify ({‘/ 1627r6) =373 2

Exponential notation for roots

The exponential notation for roots accepts any real exponent. With the exponential nota-
tion for integer roots, Evaluate converts roots of symbolic numbers to radical notation,
but otherwise produces a nontrivial response only for floating point numbers. Simplify
computes some integer roots of symbolic numbers.

Evaluate

SIS

(16)% =2 (—8)5 = /=8 (0.008)% = 0.2 (24) = 24

(3.1416)>71%% = 22.460  (~0.008)% = 0.1 + 0.173 214

Simplify

=

(16)% = 2¢/16 (—8)F =2y=1  (—0.008)% = 0.1+ 0.17321

Evaluate Numerically computes real roots of positive real numbers. For odd integer
roots of negative real numbers, it produces a complex root (see page[39).

Evaluate Numerically

col=

(o]
wl=
Il
i~

o

7 = 22.459 (—8)% =1.0+1.73213
Rationalizing a Denominator

To rationalize the denominator of a fraction, leave the insertion point in the fraction and
from the Compute menu, choose Simplify.

Simplify
1 _ 1 1 _
7= 2V2 JEes = V2 V3
V2

/8 _ 157 135 - 1VAVT - 1vAVE

S
<
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Numerical Approximations

The result of a computation is exact, or symbolic, whenever appropriate and otherwise is
a numerical approximation. You can force a numerical result to any evaluation either by
choosing Evaluate Numerically from the Compute menu, or by starting with numbers
entered in decimal notation. You obtain numerical approximations in response to any
operation when you enter numbers with decimals because such a number is interpreted
as a floating-point real number and not as a rational number (although symbolic numbers
such as 7, e, or v/2 retain their symbolic form under Evaluate).

Numerical analysis may be described as the study of errors introduced by using float-
ing point arithmetic (round-off errors) and by using a finite number of terms when an
infinite number of terms is required for exactness (truncation errors). Floating point
is a data type that is machine dependent. It is important to understand that a floating
point number is neither rational nor irrational; indeed, each floating-point number repre-
sents an infinite number of possible rational numbers and an infinite number of possible
irrational numbers.

Computer algebra systems use what is called infinite precision or extended precision
to represent integers and rationals exactly. Numbers such as sin1, /2, m, and e are
examples of numbers that are represented exactly. Evaluate Numerically leads to the
following approximations, with Digits Used in Computations and Digits Shown in
Results both set to 25 in Engine Setup and Computation Setup, respectively (see

page[29):

sinl = 0.841470984 807896 5066525023
V2 = 1.414213562373095 048 801 689
m = 3.141592653 589793238462 643
e = 2.718281828459 045235360287

Notice that the approximations are broken into blocks of length 3 decimal digits in
order to make them more readable. The numbers on the left are exact, while the numbers
on the right are merely approximations. In particular,

2
(v2) =2
exactly, whereas

1.414 213562 373 095 048 801 6892 = 2. 000 000 000 000 000 000 000 001

with Digits Shown in Results set to 25.
Contrast the results of evaluating the following expressions with Evaluate and Eval-
uate Numerically.

Evaluate Evaluate Numerically
82+37= % 82 +37=2.2162
936/14 = 4% 936,/14 = 66.857
93.6/1.4 = 66. 857 936,/14.0 = 66. 857
V234 = 3v/26 V234 = 15.297

You can change the number of digits displayed in approximations and the threshold
for scientific notation by changing settings in a dialog. You can also change the number
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of digits used in computations in a dialog. These options are discussed in greater detail
in the following pages.

Scientific Notation

Any nonzero real number x can be written in the form

r=cx 10"
with 1 < |¢| < 10 and n an integer. A number in this form is in scientific notation.
Following are some examples of scientific notation:

12 = 1.2x10
8274.9837 = 8.2749837 x 10°

0.000001234 = 1.234 x 10
—54163.02 = —5.416302 x 10*

» To write a number in scientific notation

1. Enter the number ¢ (in mathematics mode) to as many decimal places as appropriate.

2. Choose x from the Symbol Cache toolbar or from the Binary Operations symbol

panel under |%

N

3. Enter the number 10.

4. Choose Insert + Superscript, or click N* , and enter the integer n in the input
box.

There is a keyboard shortcut that does some of the work for you.

» To write a number in scientific notation using a keyboard shortcut
1. Enter the number ¢ (in mathematics mode) to as many decimal places as appropriate.

2. Type ttt while still in mathematics mode.

(This automatically turns into x 10%'. The superscript box is at the right of the 10—to
see it you must have View + Input Boxes checked on.)

3. Place the insertion point in the superscript input box and enter the integer n.

The results of a numerical computation are sometimes returned in scientific notation.
This happens when the number of digits exceeds the setting for Threshold for Scientific
Notation. See page[31|for details on changing this setting.

Computation and Display of Numerical Results

The number of digits used in numerical computations and the display of numerical re-
sults are controlled by settings you can change. You can change the defaults that ap-
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ply generally using Engine Setup and Computation Setup, respectively, on the Tools
menu. You can override the Computation Setup default for the number of digits shown
in results for individual documents using Settings from the Compute menu. These var-
ious settings affect the accuracy and the appearance of numerical results.

Digits Used in Computations

» To set global defaults for the number of digits used in computations

1. From the Tools menu, choose Engine Setup.
2. Select the General page.

3. Increase or decrease the number in the box.

MuPAD Settings | % |

General |EerrHﬂndIing|

Digits Used in Computations: 20 E

If you choose a large number, you improve accuracy, but computations may be sig-
nificantly slo